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Program Operation

The following discussion explains how, within the ArcGIS® environment, a CEDRA-AVland™
user can (a) define a horizontal alignment with random points, (b) extract cross-sections and
profile data from contour strings and (c) create a fully annotated profile.

Configuring ArcMap® with the appropriate CEDRA-AVland™  toolbars

In order to perform the above mentioned work, within ArcMap, the user must first display the
CEDRA-AVland menus and tools, to do so perform the following steps presented below:

➤  1 Invoke ArcMap by double-clicking on the ArcMap icon displayed on the desktop, or
by selecting the Start button in the task bar, then selecting the Programs menu item
followed by selecting the ArcGIS menu, and finally selecting the ArcMap menu item.

➤  2 Select the radial button to the left of
the A new empty map label, and then
click at the OK button (see Figure 1).

➤  3 Select the Tools menu item, and then
select the Customize... sub menu item.
Once the Customize form is displayed
(see Figure 2) make certain the
Toolbars tab is active, and select the
following toolbars so that they are
displayed.
? Editor
? CEDRA-AVlandHAlignment-Menus
? CEDRA-AVlandHAlignment-

Tools
? CEDRA-AVlandVAlignment-

Menus
? CEDRA-AVlandVAlignment-

Tools
? CEDRA-AVland-CrossSections
? CEDRA-AVcad-Menus and then

click at the Close button to close
the Customize dialog box.

PROGRAM
OPERATION

Figure 1 - Project Selection

Figure 2 - Toolbar Selection
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Any other CEDRA related toolbars can be added as desired.  The other toolbars provide
functionality which may prove useful for performing tasks other than those outlined
at the beginning of this paper.

➤  4 Rearrange the toolbars so that they are displayed as shown in Figure 3.

Figure 3 - ArcMap Project Layout Window
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Loading the Digital Terrain Model Themes

Once the appropriate toolbars have been displayed and positioned, the base map data including
the digital terrain themes (layers) should be added to ArcMap.  To do so, perform the following:

➤  5 Select the Add Data  button, navigate to the appropriate directory and select the

digital terrain themes (layers) and then select the Open button to add these themes
(layers) to the map.

➤  6 Select the View menu item followed by selecting the Data Frame Properties... sub
menu item.  See Figure 4.  It is impor-
tant to set the Map and Display units
prior to performing any analytical
work.  Therefore, in the drop-downs
to the right of the Map and Display
labels, within the Units frame under
the General tab, select the appropri-
ate units (typically feet or meters),
then select the OK button.

➤  7 Select the Full Extent  button to

zoom to the full extent of the digital
terrain model.

➤  8 Select the File menu item, then select
the Save As... sub menu item, navigate to the directory where the work is to be stored,
enter a desired document filename and select the Save button to save the work done
to this point.

Defining the Current Working Directory

Prior to performing any work with the CEDRA-AVland software,
the directory where any new information will be stored should be
specified.  This location is referred to as the current working
directory.  Any new files that are created by CEDRA software are
stored in the current working directory.  This includes shapefiles,
text files and personal geodatabases.

Any other data can
be added to the
map, if desired.

This includes the
layer containing

the lines which
represent the

horizontal align-
ments.

Figure 4 - Data Frame Properties

Figure 5 - Set Work-
ing Directory
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➤  9 From the CEDRA Commands combo-box select the Set Working Directory menu item.
Navigate to the folder where any new data is to be stored and select the folder.  Once
this is done, select the Select button.  In the low
left corner of the application window, the com-
mand will display the pathname of the current
working directory in the low left corner of the
application window.

➤  10 Depending upon the map units which are being
used, the user may need to specify the units of
measure for the CEDRA-AVland properties.
To do so, from the CEDRA Commands combo-
box select the AVland Properties... menu item.
The dialog box of Figure 6 is displayed.  If the
map units are set to Meters, then select the
radial button to the left of the SI label in the Data
Storage Units and Data Entry Units frames at
the top of the properties dialog box.  Once this
is done select the OK button.

Verifying the Digital Terrain Model

In order to extract cross-sections and profile data from contour strings, the layer which contains
the contour strings must have an attribute (field), called either Z or ELEVATION, which contains
the elevation value of the contours.  The reader should examine the attributes of the contour
string layer and verify that a field containing either of these two names exists.

If this attribute does not exist, the following steps can be
performed to create the required field.

➤  11 Right-click in the TOC on the name of the layer that
contains the contour strings to display the command
options of Figure 7, and select the Open Attribute
Table command.  The table of said layer is now dis-
played as shown in Figure 8.

➤  12 Click at the Options button in the low right corner of
Figure 8 to display the available operations shown in
Figure 9.

Figure 6 - AVland Properties

Figure 7
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➤  13 Select  the Add
Field... option to dis-
play the dialog box
of Figure 10.

➤  14 In said dialog box:
• Enter Z in the

data field to the
right of the
Name: label,

• Scroll in the
Type: data field,
and select the Double option (note the slight change in
the window,

• Enter 18 to the right of the Precision data field,
• Enter 6 to the right of the Scale data field, and then
• Click at the OK button to create the new attribute (field).

Figure 8 - Table of the Contours Layer

Figure 9 Figure 10

Figure 11
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The Z field has now been added to the table as shown in Figure 11.  We will now transfer
the values from the Contour field into the Z field.  Note that the command options shown
on the right side of  Figure 11 will not be displayed at this time.

➤  15 Right-click on top of the data field heading Z in the table of the contour strings, to
display the command options shown in Figure 11.  Depending upon various factors,
the positioning of this command options window may not be that as shown in Figure
11.  The message box of Figure 12 is now displayed

➤  16 Click at the Yes button.  The dia-
log box of Figure 13 is now dis-
played.

➤  17 Double-click on the CONTOUR
field name in the upper left frame
labeled Fields.  This field name is
now displayed within brackets in
the low left frame labeled Z = of
Figure 13.  Click at the OK button.

➤  18 Close the table of the layer that
contains the contour strings.

We now have a contour string
layer that can be used for extracting cross-sections and profile data.

Subdividing the Digital Terrain Model

For improved processing performance, we will now select the group of contours to be
exported into a new, smaller, layer.  This will expedite the work to be done, since we will
not have to parse through all contours of the overall project.  We will work with only
those contours within the immediate area of the horizontal alignment to be processed.

Figure 12 - Table Calculate Command Warning Message

Figure 13 - Field Calculator Dialog Box
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Figure 14 - Data Export Command

Figure 15 - Export Data

Figure 16
Confirmation to Add Exported Data

➤  19 Select the Select Features  tool, and define a rectangle

that encloses the area of immediate interest.  Note that any
contour, a part of which is contained within this rectangle will be
selected in its entirety.

➤  20 Right-click in the TOC on the name of the layer that
contains the contour strings to display the command options of

Figure 14, select the Data command op-
tion to display the additional sub-com-
mands of Figure 14, and then select the
Export Data option to display the dialog
box of Figure 15.

➤  21 Enter in the Output shapefile or feature
class: data field the pathname shown in
this data field in Figure 15, or any other
desired pathname, and then click at the
OK button to display the confirmation
message box of Figure 16.

If another existing pathname is desired,
you may click at the browse button to the
right of the Output shapefile or feature
class: data field, and select the de-
sired pathname.  The query message
box of Figure 16 is now displayed.

➤  22 Click at the Yes button to confirm
the addition of the new layer.

A new layer, the name of which is that entered in Figure 15, has now been added to the
TOC.  This will be the contour string layer used for cross-section/profile extraction.

Defining the Horizontal Alignment and Random Points

CEDRA-AVland provides two modes for defining a horizontal alignment.  The first is
by defining the alignment's start and end points and then introducing its horizontal
curves.  The second mode is by converting an existing line feature into a horizontal
alignment.  This paper discusses the second mode of alignment generation.

Depending upon
the digital terrain
model, the subdi-
vided models can

apply to more than
one horizontal

alignment.  That is,
a subdivided

digital terrain
model does not

need to be created
for each horizontal

alignment.
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➤  23 Click at the Convert Feature   tool in the Horizontal Alignment tool bar.

➤  24 Click in the view at the line represent-
ing the alignment of the new roadway.
The Yes/No/Cancel message box of
Figure 17 is displayed.

➤  25 Click at the Yes button to confirm.

➤  26 Scroll down in the Horizontal Alignment menu combo box (see Figure 18), and select
the Horizontal Alignment ID command.  The dialog box of Figure 19 is displayed.

➤  27 Enter in the data field the horizontal alignment ID
number, in this case 1, and then click at the OK button.

➤  28 Scroll down in the Horizontal Alignment menu
combo box (see Figure 18), and select the Horizontal

Alignment Data command.  The dialog box of Figure 20 is displayed.

➤  29 Enter in, and scroll down and select from the various data fields of the displayed dialog
box the data and options shown in the corresponding data fields in Figure 20, and then
click at the OK button.

➤  30 Select the Select Features

 tool, click on top of

one of the two points, hold
the keyboard shift key
down, and then click on
top of the other point.
These two points are to rep-
resent random points.

Figure 18 - Horizontal
Alignment Combo-Box

Figure 19 - Horizontal Alignment ID Entry

Figure 20 - Horizontal Alignment Data Entry

Figure 17 - Convert to HA
Confirmation Message Box

Existing line/
polyline features
can be converted
into horizontal
alignments, thereby
saving the user the
time to manually
define the
alignment's start
and end points as
well as it's PI's.

Define the current
active horizontal
alignment.

Define the current
active horizontal
alignment's
parameters.

Select the point
features that are to
be treated as
random points for
the current active
horizontal align-
ment.
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➤  31 Scroll down in the Horizontal Alignment menu combo box (see Figure 18), and select
the Random Points command.  The message 2 points added is displayed in the status
bar at the bottom of the ArcMap window.

Extracting Cross-Sections and Profile Data

➤  32 Click in the TOC on top of the name of the layer containing the contours that were
exported previously.

➤  33 Scroll down in the Cross-Section/Profile menu
combo box (see Figure 21), and select the Sec-
tions from Contours command.  The dialog box
of Figure 22 is displayed.

➤  34 Enter in, and scroll down and select from the
various data fields of the displayed dialog box the
data and options shown in the corresponding
data fields in Figure 22, and then click at the OK button.

The program now begins to
strip the cross-section at
the previously specified
station increment, and for
the previously specified
offset limits to the left and
right of the alignment.
Cross-sections have also
been stripped at the two
random points that were
previously selected.  These cross-section lines are shown in Figure 23.

➤  35 Click at View menu in the ArcMap menu bar, and from the displayed command options
select the Data Frame Properties... option to display the Data Frame Properties dialog
box.

➤  36 Make certain that the Annotation Groups tag is active, click at the og1-pln name, click
at the Remove Group button, and then click at the OK button to close the Data Frame
Properties dialog box.

Figure 21 - Cross-Section
Profile Menu Combo-Box

Figure 22
Cross-section Stripping Parameters

A table called
RANDOMPNTSdata
will be added to the
map containing the

random points.
Random points can
be used for extract-

ing cross-section
and profile data at
a specific location.

Cross-Sections and
Profile data are

extracted from the
current active

layer.

The profile offset is
the distance from

the horizontal
alignment where

the profile is to be
taken.  A value of
zero denotes that

the profile is to be
taken along the

horizontal align-
ment itself.  The left
and right x-section
limits represent the
distances to the left
and right for cross-
section extraction.

These values
should be large

enough such that a
cross-section

intersects at least
one contour string.
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Profile Plotting and Original Ground Surface Annotation Generation

➤  37 Scroll down in Text Prop-
erties commands menu
combo-box, and select the
Change Text Properties
command to display the
dialog box of Figure 24.

➤  38 Enter 2 in the Text Size
(points): data field, accept
all other data, and then click
at the OK button.

Figure 24 - Text Properties Dialog Box

Figure 23 - Stripped Cross-Section Lines Along the Alignment

Prior to plotting a
profile, the user
should set the size
of the text that is to
be used in the
profile plotting.
Depending upon
user specifications
any desired text
size value can be
entered.

The cross-sections
are stored in a
table called
og1_xsc, while the
profile is stored in
a table called
og1_pro.

The interval at
which cross-
sections are
extracted is
controlled by the
alignment's Station
Increment Value
parameter.
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➤  39 Scroll down in the Cross-Section/Profile menu combo-box (see Figure 21), and select
the Plot Original Ground Profile command.  The dialog box of Figure 25 is displayed.

➤  40 Scroll down in the
• Profile Table: data

field and select the
og1_pro option,

• for Alignment: data
field and select the 1
option, and then

click at the OK button.  A
dialog box similar to that of Figure 26 is displayed, but with different data.

➤  41 Enter in, and scroll down and select from the various data fields of the displayed dialog
box the data and options
shown in the correspond-
ing data fields in Figure 26,
and then click at the OK
button.  The profile is gen-
erated (See Figure 27).

➤  42 Click at the zoom-in 

tool, and then make a rect-
angle about the profile.

➤  43 Click at the Select Elements

Tool  and select one of

the text labels in the profile.

Figure 25
Alignment Selection for Profile Plot

Figure 26 - Profile Parameters Dialog Box

Figure 27 - The Profile

The user needs to
specify which

original ground
profile is to be

plotted and which
horizontal align-

ment the profile is
associated with.

The default values
displayed in Figure

26 represent the
actual limits of the

original ground
profile.  These

values are altered
by rounding up or
down.  Depending
upon user specifi-
cations any other

values can be
entered.

It is possible to
define the text size

to be used in
creating new

annotation by
pointing at an

existing annotation
and then using the

Set Text Size
command.

The profile is stored
in the Personal
GeoDatabase,

algX.mdb, where X
is the horizontal

alignment ID
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➤  44 Scroll down in Text Properties commands menu combo-box (see Figure 28), and select
the Set Text Size command.  The message box of Figure 29 is displayed identifying the
size of the selected text.  Click at the OK button to acknowledge the new text size.

➤  45 Scroll down in the Vertical Alignment menu combo-box (see Figure 30), and select the
Annotate Surface Elevations command.  The dialog box of Figure 31 is displayed.

➤  46 Enter the data shown
in Figure 31 in response
to the various annota-
tion parameters pre-
sented in the annotate
surface elevations dia-
log box and then click
at the OK button.

The command will then
generate along the da-
tum of the profile anno-
tation representing the
elevation at a specific station value on the original ground profile (see Figure 32).

Figure 31
Annotate Original Ground Parameters

Figure 32
Original Ground Annotation along Profile Datum

Figure 28
Text Properties

Menu Combo-Box

Figure 29 - Text Size
Figure 30

Vertical Alignment
Menu Combo-Box

We will now
generate text which
represents the
elevation of the
original ground at
specific station
values.  The user
has the option of
placing this
annotation at the
profile datum,
below the datum or
along the surface of
the original ground
profile.

The annotation
created will be the
same text size as the
profile grid text.
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Figure 33
Annotate Original Ground Parameters

Figure 34
Annotate Original Ground

Parameters

➤  47 Scroll down in the Vertical Alignment menu combo-box (see Figure 30), and select the
Annotate Surface Elevations command.  The dialog box of Figure 31 is displayed.

➤  48 Enter the data shown
in Figure 33  and then
click at the OK button.

➤  49 Click at the No button,
as shown in Figure 34,
to indicate that the an-
notation which is to be
created is to be added
to the existing annota-
tion.

The command will then
generate along the surface of the original ground
profile (see Figure 35) annotation representing
the station and elevation of the random points
that are associated with the current active hori-
zontal alignment.  Figure 36 is a "blowup" of the
annotation created by the Annotate Surface
Elevation command.

➤  50 Select the Editor button, select the Stop Editing menu item, and then click the Yes
button in the displayed query box.  All edits performed so far are now saved to disk.

We will now
annotate the

station and
elevation values of
the random points
which are associ-

ated with the
current active

horizontal align-
ment.

Figure 35
Annotate Original Ground Parameters

The profile annota-
tion is stored in the

Personal
GeoDatabase,

algX.mdb, where X
is the horizontal

alignment ID.
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Figure 36
Annotate Original Ground Parameters


